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CSC 308 Lecture Notes Week 3
Details of the Requirements Analysis Process

I. Thisweek’s material:

A. Milestone2 writeup and example.

B. Requirementsdocument HTML standards.

C. Conventions for standardized GUIs.

D. Theselecture notes.

E. Week 3 lab notes, with more on SVN.

II. Somepaper UI sketches and other paper notes are OK for Milestone 2, as long as the overall document structure
is online in HTML format.

A. Clearlylabel all paper materials so they can be referenced from the online requirements document.

1. Figurenumber and caption for screen pictures.

2. Title for other notes.

B. Make copies if you want to keep the originals.

C. Deliver to lab or Fisher’s office by 5 PM Friday.

III. Recapof general scenario guidelines covered in the Milestone 2 example.

A. Presentscenarios in atutorial style.

1. Tell an interesting, engaging, and ultimately complete story of system functionality.

2. Organize scenarios to give the reader a step-by-step presentation of what the system will be like to use.

B. Startwith scenarios showing common activities, without necessarily covering all low-level details.

C. Separatescenarios based on different categories of end user.

D. Stylisticrecommendations:

1. Leave mundane details until later, e.g., File, Edit, data entry.

2. Leave details of error handling until later.

IV. Core steps of the scenario process.

A. Describea user action that executes a command.

1. In the graphical user interfaces (GUIs) with which we are dealing, a user action is performed by some
user gesture on the screen.

2. Physically, a gesture is performed by some combination of mouse and/or keyboard actions.

3. Mosttypically, command execution is performed by selecting a menu item, pressing a command button,
or typing a keyboard action of one or more keystrokes.

B. Show the system response to the user action.

1. Ina GUI, the system response typically appears on the screen.

2. Theresponse can also be shown on some other form of output medium.

3. In some cases, the system response is not displayed directly to the user, such as the case when a change is
made to a an underlying system database that is not visible in any display.

C. Fully describe the details of the response.

1. Thedescription is a prose narrative that explains all details of display screens and underlying data.
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2. All displayscreen components are described.

3. All output effects to underlying data are described.

D. If the the system response is an input dialog of some form:

1. Show another picture of it, with representative data values filled in by the user.

2. Fullydescribe entered values and what they mean.

3. Within an input dialog, if there are non-atomic interactions, cover each using additional screen examples
and narrative.
a. Sufficiently simple cases can be covered in the narrative only, without additional screen examples.
b. These include toggles or short lists of alternative selections.

4. If there are input alternatives or options that effect what the system does, show additional versions of
filled-in dialog screens to cover all cases.

E. If the system response is output data not requiring user input:

1. Oneoutput example is sufficient if it is adequately representative of all functionality.

2. As with input dialogs, if there are output alternatives or options that fundamentally affect the content or
format of the presented information, show additional examples and narrative

V. Milestone 6 example excerpt, (to illustrate what you’re aiming for,not what’s required for earlier milestones).

A. Theaccompanying handout illustrates two completed scenarios, circa Milestone 6.

B. Notein particular that this level of completion is not expected for earlier Milestones, but it definitely is for at
least some of the Milestone 6 delieverable.

C. Thesescenarios show what you are working towards in terms of fully completed details.

1. TheCalendar Tool may be more complicated in terms of display details and options than your projects.

2. Theexcerpts were chosen to illustrate some particularly detailed scenarios.

VI. Coresteps illustrated in detail in the Milestone 6 example1

A. Describe a user action-- see Section 2.2, paragraph 2 on page 9 of the excerpt (starting with "To schedule
an appointment, ...").

B. Show system response-- see Figure 6, page 9.

C. Fully describe details of response-- see narrative in paragraphs 2 through 6 on pages 9 and 10 (through to
and including the paragraph starting "The bottommost ...").

D. If response is an input dialog:
1. Show another picture of it -- see Figure 7 on page 11.

2. Fully describe entered values-- see the narrative in paragraph 5, page 10 (starting with "After the dia-
log appears ...").

3. If non-atomic interactions, cover t hem -- see Figures 8 -11 on pages 11 and 12 and the narrative in
paragraph 6, page 10 (starting "To create a new appointment category ...").
a. Sufficiently simple cases in narrative only.
b. E.g., toggles or short lists-- see the descriptions of Security, Priority, and Remind? in para-

graphs 1-3 on page 10.

4. If input alter natives, show additional filled-in dialogs -- see Figure 12 on page 13, narrative in para-
graphs 8 through 10 on the bottom of page 10 (starting with "The user now proceeds ... ").

1 The links in the HTML version of the notes go to HTML version of the Milestone 6 requirements example. Thepage numbers
in the notes refer to the PDF excerpt of same requirements. It’s the same stuff, just in two different document formats.
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E. If response is output:
1. One screen sufficient if adequately representative -- see the weekly and yearly views in Figures 20 and

23 , on pages 22 and 24, respectively.

2. If alternati ves, provide additional examples and narrative -- see
a. Figures 13 -17 for the daily view, pages 15-19
b. Figures 18 and 19 for the weekly table view, pages 20-21
c. Figures 21 and 22 for the monthly view, page 23.

VII. Otherscenario presentation issues.

A. Ensurecomplete coverage of functional hierarchy.

1. Cover all commands and interactions, at all levels of the hierarchy, at least once.

2. Provide at least two examples of all input dialogs -- one initial version and one filled in by the user; pro-
vide additional examples to ensure adequately representative coverage.

3. Provide at least one example of all outputs, with enough additional examples to ensure adequately repre-
sentative coverage.

B. Describespecific interface layout details only as they relate to the fundamental display of information.

1. Donot address purely aesthetic look and feel issues.

2. E.g.,on the bottom of page 14, the details of display layout are described for the daily view based on
information content, not anything purely aesthetic (starting with "The day view shows ...").

C. Avoid unnecessarily repetitive presentation.

1. Referto pictures or narrative that describe common functionality.

2. E.g.,in the description of weekly view options in the last paragraph at the bottom of page 20, reference is
made to the daily view options that are the same for the weekly view, without repeating the daily view
narrative. (The paragraph starts "All of the display options available for the day view ...".)

D. Have the scenarios flow by building on information presented earlier.

1. Referto examples presented in preceding sections.

2. Whereappropriate, state assumptions about what actions the user has already taken.

3. E.g.,Section 2.3.1.1 paragraph 2 on page 14, and all the figures in Section 2.3.

E. Wherenecessary, get down to nitty gritty details.

1. Whensystem functionality is complicated or non-obvious, provide detailed and careful descriptions.

2. This is the case for the Calendar tool in the discussion of overlapping items for the daily and weekly
views, Figures 16-19, pages 18-21.

3. Usegood judgment (and the 7+/-2 rule) to defer very detailed discussions to later sections.
a. E.g.,in paragraph 3 in the middle of page 18, the most complicated details of overlapping items are

deferred to Section 2.12.1.2.
b. In the last paragraph on page 25, important details of changing and deleting scheduled items are

deferred to another section, namely 2.4.6.
c. Without explicit comment in Section 2.2, details of scheduling recurring items are deferred to Section

2.4, entitled "More Individual User Scheduling".

VIII. Interface style issues.

A. Besimple and consistent.

1. Insome cases, a complex interface may be necessary.

2. In general, however, the interface should be as simple as possible in keeping with the functionality that it
provides.

3. Consistency is always important.
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a. Theinterface should not provide two or more conflicting or redundant ways to perform the same func-
tion.

b. When different interfaces are provided for the same function, each interface should provide added
value or convenience for the user.
i. For example, a menu and toolbar interface are frequently provided for access to the same function.
ii. In this case, the value-added of the toolbar is its iconic form and quicker access than through the

menu.

B. Useinterface forms that end users can easily understand.

1. If a user has paper forms or other existing conventions for information display, duplicate the existing
forms when they work well for the user.

2. Try out various styles of interface for the user to see what works best.

C. Provide interface options to allow the user to select among alternate UI forms or display styles.

1. Whentwo are more interface forms are deemed valuable, provide an option for the user to select which
forms are visible at any giv en time.

2. For example, an option to show or hide a toolbar in addition to the menubar allows the user to select
which form to use.

IX. More on the "interesting and engaging story" told in the scenarios.

A. Thepurpose of telling an overall story throughout the requirements scenarios is two-fold:

1. tomaintain the reader’s interest, so that the reader will stay sufficiently engaged to understand the details
of the requirements, and how those details affect the way the software actually will be used;

2. toprovide overall context and continuity, so that examples presented early in the scenarios can be refined
in later scenarios.

B. Thepoint is not to entertain the reader in the way a novel or short story does.

1. Humorshould be used sparingly, if at all.

2. Thestory should stick to the facts, without flowery prose.

C. Thestory outline for the Calendar Tool scenarios goes like this:

1. Theuser schedules a couple appointments.

2. Theuser views her calendar in various ways.

3. Theuser schedules some other kinds of items.

4. Theuser deals with finer points of scheduling.

5. Anadministrative user performs specialized administrative functions.

6. Theuser sets calendar options.

D. Storyline sketch for CSTutor:

1. InstructorBuilds Simple Lesson

2. StudentViews Simple Lesson

3. InstructorBuilds Advanced Lesson

4. StudentViews Advanced Lesson

5. Instructorsand Students Chat and Interact

6. StudentsView their Stats

E. Storyline sketch for E-Class:

1. Instructorbuilds a simple lecture.

2. Instructorpresents a lecture.

3. Meanwhile,students view the lecture.
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4. Instructorbuilds an advanced lecture.

5. Studentsview advanced lecture.

6. Classroominteracts.

7. Instructorperforms admin tasks.

F. Story line sketch for the Grader:

1. Instructordownloads and sets up roster.

2. Instructoradds items and students.

3. Instructorviews charts and graphs.

4. Instructoradds gradesheet details.

5. StudentViews and Predicts Grades.

6. Studentviews historical information.

G. Storyline sketch for the Scheduler:

1. InstructorSets Up Preferences

2. AdminCreates Simple Schedule

3. AdminEdits Databases

4. AdminCreates More Complicated Schedule

5. AdminDeals with Scheduling Constraints

6. StudentViews and Comments on Schedules

H. Storyline sketch for the TestTool:

1. Instructorcreates a simple test.

2. Instructoredits question database.

3. Instructorcreates more complicated test.

4. Studenttakes test.

5. Instructorgrades test.

6. Instructormanages tests and question DB.

X. Concretedata underlying the requirements scenarios.

A. In conjunction with the scenario story line, there should be a consistent set of example data to support the
scenarios.

1. Theseexample data must be extensive enough to support all of the scenarios in the requirements.

2. At the same time, the data need be no more expansive than is necessary to support the scenarios.

3. Thedata exemplify a variety of realistic examples, in conjunction with the overall scenario story line.

4. Typically, no single scenario shows all of the data, but rather scenario-specific excerpts of it.

5. A requirements document appendix can show the complete content of the underlying example data.

B. In the case of large data collections, the scenarios are organized into two broad categories ofdata editing and
data viewing.

1. Data-editingscenarios present functionality to add, modify, and delete data elements in the collections.

2. Data-viewing scenarios present functionality to search the collections, and show the data in whatever
forms are available to the user.

3. For data-editing scenarios, a sufficient number of representative examples are shown, but there is no sce-
nario that shows each element being added individually to a large collection.

4. Rather, following scenarios that show representative data elements being added, the narrative can say
something to the effect of"The user now proceeds to add additional data elements, in the same manner
as described in the preceding scenarios."
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5. Thesubsequent data editing and viewing scenarios then display scenario-specific collection elements.

C. A fundamentally important reason to have consistent underlying data examples is to provide continuity
through the scenario story line.

1. Typically, early scenarios show data being created.

2. Subsequentscenarios show the same data being modified, and selected pieces of data being deleted.

3. After that, scenarios present viewing functionality for the same data that have been created in the preced-
ing editing scenarios.

4. Insome cases, viewing scenarios may come first, before editing details.
a. In such cases, the narrative says something to the effect of"The following scenarios assume that the

user as created some data ... . Full details of creation are covered in the scenarios of Section X."
b. Continuity is maintained by having the subsequent editing scenarios use example data that appeared in

the preceding viewing scenarios.

XI. Dataexamples for the 308 projects.

A. Discussedbelow are the major data examples for this year’s 308 projects.

1. Theseare example data that provide continuity among the scenarios that present the major functionality of
the tools.

2. Thediscussion does not cover data examples for all tool functionality; the focus is on the major stuff.

B. In the Calendar Tool requirements, there are consistent underlying calendar examples for a number of users,
and consistent examples for each of the databases.

1. Themain example used in most of the scenarios is the work calendar for a single user.
a. It has a sufficient number of scheduled items to support the scenarios for scheduling and viewing an

individual user’s calendar.
b. It provides continuity across all of these scenarios.

2. Thereare also smaller examples for the same user’s personal and off-campus calendars; these examples
support scenarios that illustrate multi-calendar functionality.

3. To support scenarios for meeting scheduling and viewing other-users’ calendars, there are underlying
example calendars for a number of other users.
a. All but one of these calendars have only a few items each, to support the scenarios for meeting-sched-

uling functionality.
b. One of the calendars has enough items to show full details of viewing other user’s calendars.

4. Thereis one full example for each of the three databases.
a. Thesehave a sufficient number of entries to support database viewing and editing operations.
b. They provide continuity across the scenarios for regular user and administrative user functionality.

5. Finally, there is an appendix that shows the complete content of the example calendars and databases.

C. Underlyingdata for CSTutor:

1. You need example lessons and a student account database.

2. A single main lesson can be used in most of the scenarios.

a. It must have a sufficient number of pages to support scenarios for lesson authoring and viewing,
including quizzing.

b. A few additional smaller lessons can be used to support the scenarios for the inter-lesson navigation,
and multiple lesson scoring for students.

3. You can provide just the shells for a number of additional lessons, to fully illustrate the lesson database
and its browsing features.

4. You also need an example student user database, that has enough student entries to support scenarios on
student/instructor interaction in chat sessions, and overall student statistics.
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D. Underlyingdata for EClass:

1. You need sample lectures and student roster.

2. A single main lecture can be used in almost all of the scenarios.
a. It must have a sufficient number of topics and slides to support scenarios on lecture preparation, pre-

sentation, viewing.
b. In particular, the lecture must varying topic depths to thoroughly illustrate the various navigation fea-

tures, including expand and collapse.

3. Oneor two additional lectures can be provided to illustrate how lectures are stored and transported.

4. You also need a sample student roster, with a sufficient number of students to illustrate all of the roster-
related functionality.

E. Underlyingdata for the Grader:

1. You need example gradesheets and an example SIS student roster.

2. A single main gradesheet example can be used in most of the scenarios.
a. It must have a sufficient number of student rows and graded-item columns to support the scenarios for

row/column operations, graphic display, and student what-if scenarios.
b. It provides continuity across all of these scenarios.

3. Additionalsmaller gradesheet examples can be used in the scenarios that show grade trends, and storage
of gradesheets on the server.

F. Underlying data for the Scheduler:
1. You need example generated schedules, and example databases.
2. A main schedule example schedule must have a sufficient number of scheduled classes to illustrate gener-

ating and editing a good schedule.
3. Additionalsmaller example schedules can be used in the scenarios that cover specialized scheduling con-

straints and preferences.
4. Theexample databases should have a sufficient number of entries to support all forms of scheduling; most

likely, a single example for each database should be sufficient.

G. Underlyingdata for the TestTool:

1. You need example tests question database(s).

2. A single main test example can be used in most of the scenarios.
a. It must have a sufficient number of questions to support the scenarios for test generation, test taking,

and test grading
b. It provides continuity across all of these scenarios.

3. Additionalsmaller test examples can be used in the scenarios that illustrate details of test generation.

4. A single main question database example must have a sufficient number of questions to support test gen-
eration and database viewing scenarios.

5. If your team chooses to work on functionality for question database sharing, then you’ll need some addi-
tional (smaller) database examples for these scenarios.

XII. Screenmaps.

A. A potentially helpful high-level view of a GUI is ascreen map that shows the flow of user interaction.

B. A screen map consists of sketches or thumbnails of interface screens, connected in a cascading tree that
depicts the order in which screens appear in response to user command selection.

C. Following are a couple sample pages of a screen map for the calendar tool, showing the top-level menus and
two lev els below theSchedule menu.

1. Whensketching out screen maps, it can be useful to sketch them out initially on a large drawing area,
such as a whiteboard.

2. In the online versions, each thumbnail in the screen map can be a link to the full-sized picture in the
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requirements.

D. Notethat screen maps arenot required for CSC 308, but you may find them helpful.
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HelpFile Edit Schedule View Admin Options               

Calendar Tool
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September 1998

Monthly Agenda

Initial Screen
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 in menubar
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   in menubar

Choose Options
    in menubar

Choose Help
 in menubar

Choose Schedule
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Calendar Tool
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Calendar Tool

File Menu

Edit Menu

Schedule Menu

View Menu

Admin Menu

Options Menu

Help Menu

New
Open ...
Close
Close All

Save
Save As ...
Save All

Print ...

Exit

Undo
Redo
Repeat ...

Cut
Copy
Paste
Delete
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Find ...
Command ...

Item
Day
Week ->
Month
Year

Next
Previous
Goto Date ...

Lists ->
Filter ->

Other User ...

Windows ->

Users ...
Groups ...
Locations ...

Global Options ->

Times and Dates ...
Scheduling ...
Viewing ...

About ...
Show Quick Help
Detailed Help ...

Appointment ...
Meeting ...
Task ...
Event ...
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File

Edit
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Choose Appointment
   in Schedule menu

Choose Schedule
     in menubar

HelpFile Edit Schedule View Admin Options               

Calendar Tool

Schedule Menu

Appointment ...
Meeting ...
Task ...
Event ...

Categories ...

Schedule

 Choose Meeting
in Schedule menu

    Choose Task
in Schedule menu

   Choose Event
in Schedule menu

Appointment Dialog
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Start Time:

Duration:

Date:

End Date:

Title:
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S M T W Th F S

Interval:

Location:

Details:

Priority:

Schedule an Appointment

Security:Category:

hr min

on screenminutes beforeRemind? 15

OK CancelClear

Meeting Dialog

   Earliest
Possible Date:

 Latest
End Date:

Title:

 Earliest
Start Time:

Schedule a Meeting

weeklyRecurring? Interval:

Location: mustPriority:

Details:

publicSecurity:Category:

on screenminutes beforeRemind? 15

Attendees:
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End Date:
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Possible Date:
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Duration:
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Minutes:

Details ...

List Times ... CancelClearOptions ...

Task Dialog
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Due Date:
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Details:

Priority:

Schedule a Task

Security:Category:

on screenminutes beforeRemind? 15

OK CancelClear

Due Time:
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Event Dialog

Start Date: End Date:

Title:

Schedule an Event

Category:

OK CancelClear

publicSecurity:

ChangeAdd Delete

Done

Current Categories:

holiday

Edit Categories

Edit Categories Dialog

Choose Categories ...
  in Schedule menu

Possible Times List
Possible Meeting Times

8-9 AM Monday September 21
12-1 PM Monday September 21
2-3 PM Monday September 21
5-6 PM Monday September 21
12-1 PM Thursday September 24
5-6 PM Thursday September 24
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Confirm ... Cancel

Confirmation Dialog

Scheduling Options

Allowable days for non-recurring meetings: 

Schedule at same time as must items? 

Meeting Scheduling Options

Schedule at same time as optional items?  no  yes

Maximum length of possible times list: 20

OK CancelClear

Start on: 

 any time

 half hour

 full hour

 quarter hour

 no  yes

S M T W Th F S

Press Possible
 Times button

Press Confirm
       button

Press Options
      button

http://www.csc.calpoly.edu/~estier/departmeMinutes:

public

must

Start Time:

Duration:

Date:

End Date:

Title:

weeklyRecurring?
S M T W Th F S

Interval:

Location: Priority:

Details:

Security:Category:

hr min

on screenminutes beforeRemind? 15

Attendees:

Confirm a Meeting

Computer Science Staff Meeting

September 23, 1998

1

14-238

csstaff

Agenda:
  1. Duty assignments for Fall quarter
  2. News of office remodeling project
  3. Introduce new staff members
  4. Promotions
  5. Initial prep for accreditation visits

8 AM

Scheduled By: estier On: 15sep98 08:24:01

OK CancelClear

Send email notification?

Host: csc.calpoly.edu
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XIII. A view of requirements evolution -- Calendar Tool command menus.

A. Given below is a Subversion log report and snapshots for the evolution of the command menus of the Calen-
dar Tool.

B. Thelog entries are those reported by the ‘svn log’ command, which displays the revision history for a file.

1. Thereis some book keeping at the top of the file that you can mostly ignore.

2. Theentries describe versions 1.1 through 1.8, shown as being checked in on Friday afternoons throughout
this Fall quarter.

3. Thelog messages are those record with the ‘-m’ argument to the ‘svn commit’ command.

4. Thelog history is shown for the file name "menus.idr", which isidraw source file for the menus
screen.

5. For images, you can check in the source file and/or the generated GIF or JPEG image.

C. Hereare excerpts from the Subversion log report:

------------------------------------------------------------------------------
r8 | gfisher | 2007-11-26 15:01:04

Replaced ‘Admin Global Options’ with ‘Central Host’, ‘List Admins’, and
‘Login’. Also added ’View Today’, ’View Windows Close’, and ‘File Save
Config’.
------------------------------------------------------------------------------
r7 | gfisher | 2007-11-19 14:20:41

Added ’Magnetize’ item to ’Windows’ menu. Made ’Admin->Global Options’ menu
have exactly the same items as ’Options’ menu. Added four new items to Filter
submenu.
------------------------------------------------------------------------------

...
------------------------------------------------------------------------------
r3 | gfisher | 2007-10-22 15:16:25

Added an ’All Items’ item to ’View->Lists’ submenu. Nuked submenus for Admin
User, Group, and Room in favor of uniform dialog for each.
------------------------------------------------------------------------------
r2 | gfisher | 2007-10-15 14:25:26

A nice bit of revamping to add separator lines between items, add the new Help
menu, add Sorting to View->Lists submenu, add multi-widow-mode-on-off to
View->Windows submenu, redesign Admin menu, and move entire Options menu to
Edit->Preferences.
------------------------------------------------------------------------------
r1 | gfisher | 2007-10-08 14:51:35
Initial checkin.

D. Hereare the screen shots for versions 1.1 and 1.8 in the history
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